
Chapter 1

Introduction to 
Autodesk Revit 

MEP 2014
After completing this chapter, you will be able to:
• Understand the basic concepts and principles of Revit MEP 2014
• Understand various terms used in Revit MEP
• Describe the parametric behavior of Revit MEP
• Start the Revit MEP 2014 program
• Understand the interface of Revit MEP
• Access the Revit MEP 2014 Help

Learning Objectives
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introduction to Autodesk Revit MEP
Welcome to the realm of Autodesk Revit MEP, a powerful software for MEP engineering that 
provides purpose-built tools for design, engineering, and analysis.

Autodesk Revit MEP that was introduced in 2011 is specifically built for MEP engineers and 
designers. Since then, it has become very popular in the Building Information Modeling (BIM) 
workflow. This software provides engineers and designers with tools for the analysis, modeling, 
and design of various building elements and systems for MEP (Mechanical, Electrical, and 
Plumbing) services. 

Revit MEP is a BIM software that helps the users, to coordinate the documentation of MEP 
designs with other engineering disciplines. Its integrated parametric modeling technology is 
used to create the information model of a project and to collect and coordinate information 
across all its representations. In Autodesk Revit MEP, drawing sheets, 2D views, 3D views, 
sectional view, callout details, and schedules directly represent the same building information 
model (BIM) as the real one does. Autodesk Revit MEP is developed with an approach to 
bring the Mechanical, Electrical, and Plumbing engineers together under the BIM framework 
and make the building services system efficient and interoperable with the other systems. In 
Revit MEP, a designer can not only work with various pre-designed elements of different MEP 
disciplines but can also model customized elements and add parameters to them. This helps 
in modelling complex designs with various permutations. Different disciplines of Revit MEP 
are briefly described next.

Mechanical Discipline
A designer working with mechanical discipline can develop an HVAC (Heating Ventilation 
and Air Conditioning) system, keeping in view the energy requirements of that building. The 
study of the energy requirement of the building is very essential for developing an efficient 
and cost effective design. In mechanical discipline, you can design the whole ducting network 
with the ventilation layout plan. You can also route the piping or ducting networks manually 
or generate routing solutions by using various tools in this software.

Electrical Discipline
While working with the electrical discipline you can design an electrical system. In this system, 
you can add various lighting fixtures, switches, alarms, communication devices, and more as 
per the requirement of the project. You can also add panels and prepare  panel schedules and 
perform the load analysis. Further, you can connect the devices and fixtures through logical 
circuits.

Plumbing Discipline
In this discipline, you can design a plumbing system for a project. In the plumbing system, 
you can add plumbing fittings, accessories, and fixtures as per the requirement of a project. In 
addition you can also design fire fighting system for a building and add fire safety components 
to the system.
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Autodesk Revit MEP as a building 
Information modeler (BIM)
The history of computer aided design and documentation dates back to the early 1980s 
when architects and engineers began using this technology for documenting their projects. 
Realizing its advantages, information sharing capabilities were developed, especially to share 
data with other consultants. This led to the development of object-based CAD systems in the 
early 1990s. Before the development of these systems, objects such as HVAC components, 
pipes, plumbing fixtures, electrical fixture, and more were stored as a non-graphical data 
with the assigned graphics. These systems arranged the information logically but were unable 
to optimize its usage in a building project. Realizing the advantages of the solid modeling 
tools, the mechanical and manufacturing industry professionals began using the information 
modeling CAD technology. This technology enabled them to extract data based on the 
relationship between model elements. 

The Building Information Modeling (BIM) provided an alternative approach to building 
design, construction, and management. This approach, however, required a suitable technology 
to implement and reap its benefits. In such a situation, the use of parametric technology with 
the Building Information Modeling approach was envisaged as an ideal combination. In 1997, 
a group of mechanical CAD technologists began working on a new software dedicated to the 
building industry. They developed a software that was suitable for creating MEP projects. This 
led to the development of Autodesk Revit MEP. 

Autodesk Revit MEP is a design and documentation platform, in which a digital MEP model 
is created using the parametric elements such as HVAC system, mechanical equipments, 
plumbing network, fire fighting,  and so on. All MEP elements have inherent characterstics, and 
therefore, they can which can be tracked, managed, and maintained by using computer. 

Basic Concepts and Principles 
Autodesk Revit MEP enables you to envisage and develop an MEP model with actual 3D 
parametric elements. It provides a new approach to MEP design and  implementation process. 
It replicates the way MEP engineers conceive the structure of an MEP system. For example, 
the 2D CAD platforms mostly use lines to represent all elements, as shown in Figure 1-1. 
However, in Autodesk Revit MEP, you can create the MEP model of a building project using 
3D elements, such as HVAC components, pipes, plumbing fixtures, electrical fixtures, as 
shown in Figure 1-2.

Using these 3D elements, you can visualize the MEP project with respect to its scale, volume, 
and proportions. This enables you to study design alternatives and develop superior quality 
design solutions. Autodesk Revit MEP automates routine drafting and coordination tasks and 
helps in reducing errors in documentation. This, in turn, saves time, improves the speed of 
documentation, and lowers the cost for the users.
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Figure 1-1  CAD project created using 2D lines 

Figure 1-2  An MEP project created using parametric elements
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Understanding the Parametric Building Modeling Technology
A project in Autodesk Revit MEP is created using the inbuilt parametric building elements. 
The term ‘parametric’ refers to parameters that defines relationship between various building 
elements. Some of these relationships are defined by Autodesk Revit MEP itself and others 
by the users. For example the relationship between air terminals and ceilings are defined by 
MEP and the relationship between connectors and ducts are defined by the users.

In an MEP project, each element has inbuilt bidirectional associativity with many other 
elements. These elements together forms an intergrated builing information model. This 
model contains all data needed for the design and development of the project. You can then 
use this data to create project presentation views such as ceiling plans, sections, elevations, and 
so on for docuumentation. As you modify the model while working in certain views, Autodesk 
Revit MEP’s parametric change engine automatically updates other views. This capability is, 
therefore, the underlying concept in Autodesk Revit MEP.

Autodesk Revit MEP’s parametric change engine enables you to modify design elements at 
any stage of the project development. As changes in the model are reflected immediately 
and automatically in the project, the time and effort required in coordinating the changes in 
other views is saved. This feature provides immense flexibility in the design and development 
process along with an error-free documentation.

Autodesk Revit MEP also provides a variety of in-built parametric element libraries that can 
be selected and used to create a building model. It also provides you with the flexibility to 
modify the properties of these elements or to create your own parametric elements, based on 
the project requirement.

Terms Used in Autodesk Revit MEP
Before working with Autodesk Revit MEP, it is important to understand the basic terms used 
for creating a building model. Various terms in Autodesk Revit MEP such as project, level, 
category, family, type, and instance are described next.

Autodesk Revit MEP Project
A project in Autodesk Revit MEP is similar to an actual project. In an actual project, the entire 
documentation such as drawings, 3D views, specifications, schedules, cost estimates, and so 
on are inherently linked and read together. Similarly, in Autodesk Revit MEP, a project not 
only includes the digital 3D MEP model but also its parametrically associated documentation. 
Thus, all components such as the building model, its standard views, MEP drawings, and 
schedules together form a complete project. A project file contains all project information such 
as building and MEP elements used in a project, drawing sheets, schedules, cost estimates, 3D 
views, renderings, and so on. A project file also stores various settings such as environment, 
lighting, and so on. As the entire data is stored in the same file, so it becomes easier for 
Autodesk Revit MEP to coordinate the database.
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Levels in a Building Model
In Autodesk Revit MEP, a building model is divided into different levels. These levels may be 
understood as infinite horizontal planes that act as hosts for different elements such as roof, 
floor, ceiling, and so on. Each element that you create belongs to a particular level. 

Subdivisions of Elements into Categories and Subcategories
Apart from MEP elements, an Autodesk Revit MEP project also contains other associated elements 
such as annotations, imported files, links, and so on. These elements have been divided into 
the following categories: 

Model Category	 : 

Annotation Category	 : 

Datum Category	 : 

View Category		  : 

Consists of various MEP elements used in creating services, and so on   
model such as HVAC elements, ducts, air terminals, diffusers,  
pipes, plumbing fixtures, electrical conduits and more

Consists of annotations such as dimensions, text notes, tags, 
symbols, and so on

Consists of datums such as levels, grids, reference planes, and 
so on

Consists of interactive project views such as the architectural, 
mechanical, and plumbing floor plans, elevations, sections, 3D   
views, and renderings

In addition to these four categories, other categories such as Imported, Workset, Filter, and 
Revit Categories can also exist, if the project has imported files, enabled worksets, or linked 
Autodesk Revit MEP projects, respectively.

Families in Autodesk Revit MEP
Another powerful concept in Autodesk Revit MEP is family. A family is described as a set of 
elements of the same category that are grouped together based on certain common parameters 
or characteristics. Elements of the same family may have different properties, but they all 
have common characteristics. For example, Rectangular Diffuser - Round Connection is 
an air diffuser family and it contains different sizes of air diffusers. Family files have the .rfa 
extension. You can load additional MEP component families from the libraries provided in 
Autodesk Revit MEP package. 

Families are further divided into certain types. A type or family type, as it is called, is a specific 
size or style of a family. For example, Rectangular Diffuser - Round Connection 24x24 - 10 
Neck in Metric (M_Rectangular Diffuser - Round Connection 600x600- 230 Neck) is an air 
diffuser type. All uses of the same family type in a project have the same properties. Family 
and family types can also be used to create new families using the Family Editor. 

Instances are the actual usage of model elements in a MEP model or annotations in a 
drawing sheet. A family type, created at a new location, is identified as an instance of the 
family type. All instances of the same family type have the same properties. Therefore, when 
you modify the properties of a family type, the properties of all its instances also get modified. 
The family categorization of Revit elements is given below:
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Model Category	 : Air diffuser
Family	 		  : Rectangular Diffuser - Round Connection
Family type		  : Rectangular Diffuser - Round Connection 24x24 - 10 Neck
Instance		  : Particular usage of a family type

The hierarchy of service elements in Autodesk Revit MEP plays an important role in providing 
flexibility and ease in managing a change in a building model. Figure 1-3 shows the hierarchy 
of categories and families in a typical Autodesk Revit MEP project. 

Figure 1-3  Hierarchy of Autodesk Revit MEP categories and families

Autodesk Revit Elements

Model Category Annotation Category Datum Category  View Category

Ducts
Diffusers
Pipes
Wires
Conduit
Fixtures
Cable trays

Dimensions
Text Notes
Tags
Symbols
Room tag
Spaces tag

Grids
Levels
Reference Planes

Ceiling Floor
Plans
Elevations
Sections
3D Views
Callout views

Creating an MEP Model Using Parametric Elements
Another classification of categories of elements followed in Autodesk Revit MEP is based on 
their usage. Autodesk Revit MEP uses five classes of elements: Host, component, annotation, 
view, and datum. Hosts are the element categories that form the basic system of an MEP model 
and include model elements such as ducts, pipes, cables, and more. Components are the 
elements that are added to host elements or act as stand-alone elements such as air terminals, 
diffusers, and conduits. Annotations are the 2D, view-specific elements such as dimensions, 
tags, text notes, and so on that add content to the project documentation. Views represent 
various orientations of a building model such as plans, elevations, sections, 3D views, and so 
on. Datum refers to the reference elements that assist you in creating a building model, which 
include grids, levels, reference planes, and so on.

There is no specific methodology available for creating a services model in Autodesk Revit 
MEP. It provides you with the flexibility of generating the MEP model based on the project 
requirement, design complexity, and other factors. However, the following steps describe 
a general procedure that may be followed for creating an MEP model using the built-in 
parametric elements provided in Autodesk Revit MEP. 

In Revit MEP, you can start designing a project for individual discipline (Mechanical, Electrical, 
or Plumbing) by selecting the specific template. For example, to design a project for a 
mechanical  discipline, you can select the Mechanical-Default .rte (Mechanical-Default_Metric.
rte) template file. Alternatively, you can start a project to work in all disciplines by selecting 
the Systems-Default .rte (System-Default_Metric.rte) template file.
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Once you have started a project, you need to copy the levels of the architectural model to the 
current project or create additional levels as per the requirement. Next, you can start with 
any of the disciplines by activating the specific view from the Project Browser. For example, 
to start with mechanical discipline, activate the desired mechanical plan view under Views 
(Discipline) > Mechanical node from the Project Browser.

In Revit MEP, there are specific workflows for each disciplines as per the requirement of the 
project. The workflow for disciplines generally include analysis, design, and documentation. 
For mechanical discipline, you need to analyze spaces to design an appropriate HVAC system. 
Then, based on the analysis you need to place air terminals, equipment, and design ducts  for 
the system. Figure 1-4 shows an example of a mechanical system.

Figure 1-4  Mechanical system with its elements

Visibility/Graphics Overrides, Scale, and Detail Level 
Autodesk Revit MEP enables you to control the display and graphic representation of a single 
element or the element category of various elements in the project views. This is done by 
using the visibility and graphics overrides tools. You can select a model category and modify 
its linetype and detail level. This can also be done for various annotation category elements 
and imported files. These settings can be done for each project view based on its desired 
representation. You can also hide an element or an element category in a view using the Hide 
in view and Isolate tools. You can override the graphic representation of an element or an 
element category in any view using the Visibility/Graphics tool.

The scale is another important concept in an Autodesk Revit MEP project. You can set the 
scale for each project view by selecting it from the available list of standard scales such as 
1/16”=1’0”, 1/4”=1’0”, 1”=1’0”, 1/2”=1’0” for Imperial system or 1: 50, 1: 100, 1: 200, 
1: 500 for Metric system. As you set a scale, Autodesk Revit MEP automatically sets the detail 
level that is appropriate for it. There are three detail levels provided in an Autodesk Revit 
MEP project: Coarse, Medium, and Fine. You can also set the detail level manually for each 
project view. Each detail level has an associated linetype and the detail lines associated with 
it. The details of annotations, such as dimensions, tags, and so on, are also defined by the 
selected scale.
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Extracting Project Information
A single integrated building information is used to create and represent a building project. 
You can extract project information from a building model and create area schemes, schedule, 
and cost estimates, and then add them to the project presentation.

Autodesk Revit MEP also enables you to export the extracted database to the industry 
standard Open Database Connectivity (ODBC) compliant relational database tables. The use 
of the building information model to extract database information eliminates the error-prone 
method of measuring building spaces individually. 

Creating an MEP Drawing Set
After creating the building model, you can easily arrange the project views by plotting them 
on the drawing sheets. The drawing sheets can also be organized in a project file based on the 
established CAD standards followed by the firm. In this manner, the project documentation 
can easily be transformed from the conceptual design stage to the design development stage 
and finally to the construction document stage. The project view on a drawing sheet is only a 
graphical representation of the building information model. Therefore, any modification in it is 
immediately made in all associated project views, keeping the drawings set always updated.

Creating an Unusual Building Geometry
Autodesk Revit MEP also helps you conceptualize a building project in terms of its volume, 
shape, and proportions before working with actual building elements. This is done by using 
the Massing tool, which enables you to create quick 3D models of buildings and conduct 
volumetric and proportion study on overall masses. It also enables you to visualize and create 
an unusual building geometry. The same massing model can then be converted into a building 
model with individual parametric building elements. It provides continuity to the generation 
of building model right from sketch design to its development. You can also create various 
custom MEP elements as per the project requirement and then load them to the project.

Flexibility of Creating Special Elements
Autodesk Revit MEP provides a large number of in-built family types of various model 
elements and annotations. Each parametric element has the associated properties that can 
be modified based on the project requirement. 

Autodesk Revit MEP also enables you to create the elements that are designed specifically 
for a particular location. The in-built family editor enables you to create new elements using 
family templates. This provides you with the flexibility of using in-built elements for creating 
your own elements. For example, using the furniture template, you can create a reception 
desk that is suitable for a particular location in the design. 

Creating Services Layouts
Autodesk Revit MEP provides you with an extensive in-built library of MEP elements that 
can  be used to add elements such as  ducts, air terminals, diffusers, conduits, and so on to a 
project. This helps MEP consultants to include these service elements in the basic architectural 
building model and check for inconsistency, if any.
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Working on Large Projects
In Autodesk Revit MEP, you can work on large projects by linking different building projects 
together. For a large project that consists of a number of buildings, you can create 
individual buildings as separate projects and then link all of them into a single base file. The 
database recognizes the linked projects and includes them in the project representation of 
the base file. 

For example, while working on a large educational institution campus, you can create separate 
project files for academic building, administration area, gymnasium, cafeteria, computer centre, 
and so on, and then link them into the base site plan file. In this manner, large projects can 
be subdivided and worked upon simultaneously.

Working in Large Teams and Coordinating with Consultants
In Autodesk Revit MEP, worksets enable the division of the MEP model into small editable sets 
of disciplines such as Mechanical, Electrical and Plumbing. The worksets can be assigned to 
different teams working on the same project and then their work can easily be coordinated by 
sharing the files in the central file location. The effort required to coordinate, collaborate, and 
communicate the changes between various worksets is taken care of by the computer. Various 
consultants working on a project can be assigned a workset with a set of editable elements. 
They can then incorporate their services and modify the associated elements. 

For example, a high rise commercial building project can be divided into different worksets with 
independent teams working on different disciplines such as Mechanical, Electrical, Plumbing, 
architecture, structure, and so on. The structural consultants can be assigned the exterior skin 
and the core workset, in which they can incorporate structural elements. Similarly, the rest of 
the teams can work independently on different worksets. 

Starting Autodesk Revit MEP 2014
You can start Autodesk Revit MEP by double-clicking on the Revit MEP 2014 icon on the 
desktop. Alternatively, you can choose the Start button at the lower left corner of the screen 
(default position) in the taskbar and then choose All Programs > Autodesk > Revit MEP 
2014 > Revit MEP 2014, as shown in Figure 1-5 to display the interface screen, as shown in 
Figure 1-6. Note that this path is for the Windows 7 operating system.

Note
The path for starting Autodesk Revit MEP depends on the operating system being used.

The screen interface has three sections: Projects, Families, and Resources. The options 
in the Projects section are used to open a new or an existing project. The options in the 
Families section are used to open a new or an existing family. You can also invoke the Conceptual 
Mass environment from this section to create a conceptual mass model. If you choose the 
Autodesk Seek option from the Families section, you will be directed to http://seek.autodesk.
com/localeTaxBrowse.htm?category=en_us:adsk:revit-mep&locale=en-us&globaldd=globaldropdown.
option.b and the Autodesk® Revit MEP Web Library - US Edition page will open. From this 
page, you can download various components for your project. 
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Figure 1-5  Starting Autodesk Revit MEP 2014 using the taskbar

Figure 1-6  The interface screen of Autodesk Revit MEP 2014

In the Resources section, you can choose the What’s New? option to get information about 
the new tools and features in Autodesk Revit MEP 2014. In addition, you can choose the 
Help option from the Resources section. On doing so, you will be directed to the link 
http://wikihelp.autodesk.com/Revit/enu/2014 Also, the Autodesk WikiHelp page with the Revit 
User’s Guide link will open. In the Resources section, you can choose the Getting Started 
Video option to view the videos related to basic and advanced concepts in Autodesk Revit 
MEP 2014. You can also choose the Mosaic Community Portal option from the Resources 
section to view various online communities related to Autodesk Revit. Various articles on the 
basic and advanced topics of Revit MEP 2014 posted by members of these communities can 
also be viewed in this section.
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In the Projects section, choose the Open option; the Open dialog box will be displayed. 
Browse to the desired location in the dialog box and select the file. Now, choose the Open 
button to open the file. 

To open a new project file, choose the New option from the Projects section. Alternatively, choose 
New > Project from the Application Menu; the New Project dialog box will be displayed. In 
this dialog box, make sure that the Project radio button is selected, and then choose the OK 
button; a new project file will open and the interface screen is activated.

User Interface
In Autodesk Revit MEP, the user interface consists of the Ribbon, Drawing area, Properties 
Palette, Status Bar, and the View Control Bar, as shown in Figure 1-7. In Autodesk Revit MEP, 
all tools are grouped in several panels in the ribbon. 

Figure 1-7  The Autodesk Revit Structure 2014 user interface screen

The ribbon, which contains task-based tabs and panels, streamlines the structural workflow 
and optimizes the project delivery time. In Autodesk Revit MEP, when you select an element 
in the drawing area, the ribbon displays a contextual tab that comprises of tools corresponding 
to the selected element. The interface of Autodesk Revit MEP is similar to the interfaces of 
many other Microsoft Windows-based programs. The main components in the Revit interface 
are discussed next.

Title Bar
The Title Bar, docked on the top portion of the user interface, displays the program’s logo, 
name of the current project, and the view opened in the viewing area. Project 1- Floor Plan: 
Level 1 is the default project name and view displayed. 
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Ribbon
The ribbon, as shown in Figure 1-8, is an interface that is used to invoke tools. When you 
open a file, the ribbon is displayed at the top in the screen. It comprises task-based tabs and 
panels, refer to Figure 1-8, which provide all tools necessary for creating a project. The tabs 
and panels in the ribbon can be customized according to the need of the user. This can be 
done by moving the panels and changing the view states of the ribbon (the method of changing 
the ribbon view state is discussed later in this chapter). The ribbon has three types of buttons: 
general, drop-down, and split. These buttons can be used from the panels. 

Figure 1-8  Different components of a ribbon

Tip: Tooltips appear when you place the cursor over any tool icon in the ribbon. The name 
of the tool appears in the box, assisting you in identifying each tool icon. 

In the ribbon, you can move a panel and place it anywhere on the screen. To do so, press and 
hold the left mouse button on the panel label in the ribbon, and then drag the panel to a 
desired place on the screen. Next, use the 

Figure 1-9  Choosing the Return Panels to Ribbon 
button

tools of the moved panel and place 
the panel back to the ribbon. To do 
so, place the cursor on the moved 
panel and choose the Return Panels 
to Ribbon button from the upper 
right corner of this panel, as shown 
in Figure 1-9; the panel will return to 
the ribbon.

Changing the View States of the Ribbon
The ribbon can be displayed in three view states by selecting any of the following four options: 
Minimize to Tabs, Minimize to Panel Titles, Minimize to Panel Buttons, and Cycle through 
all. To use these options, click on the down arrow located on the right of the Modify panel, 
refer to Figure 1-10; the arrow will be highlighted. Next, click on the down arrow; a flyout will 
be displayed, as shown in Figure 1-10. 

Figure 1-10  Various options in the flyout for changing the view state of the ribbon 
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From this flyout, you can choose the Minimize to Tabs option to display only the tabs in the 
ribbon. If you choose the Minimize to Panel Titles option, the ribbon will display the titles 
of the panels along with the tabs. You can choose the Minimize to Panel Buttons option to 
display panels as buttons along with tabs in the ribbon.

Note
If the ribbon is changed to a different view state, then on placing the cursor over the first arrow 
on the right of the Modify tab, the Show Full Ribbon tooltip will be displayed. Click on the 
arrow; the full ribbon will be displayed. 

The table given next describes various tabs in the ribbon and their functions.
 

Tab 	   Description

Systems Contains tools for creating an MEP 
model

Architecture Contains tools for creating an architectural 
model

Analyze Contains tools for analyzing the structural 
model

Insert Contains tools for inserting or managing 
secondary files such as raster image    
files and CAD files 

Annotate Contains tools for documenting a 
building model such as adding texts and  
dimensions

Massing & Site  Contains tools for creating massing and 
site elements

Collaborate Contains tools for collaborating the project 
with other team members (internal and 
external) 

View C o n t a i n s  t o o l s  f o r  m a n a g i n g 
and modifying the current views,  
switching views, and so on.

Manage Contains tools for specifying the 
project and system parameters and   
settings

Add - Ins Contains add in links to interoperable BIM 
softwares

Modify	 Contains tools for editing elements in the 
model
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Contextual Tabs in the Ribbon
These tabs are displayed when you choose certain tools or select certain elements. They contain 
a set of tools or buttons that relate only to a particular tool or element.

For example, when you invoke the Duct tool, the Modify | Place Duct contextual tab is 
displayed. This tab has the following panels: Select, Properties, View, Measure, Geometry, 
Clipboard, Create, Modify, Placement, and Placement Tools. The Select panel contains the 
Modify tool. The Properties panel contains the Properties button and the Type Properties tool. 
The Mode panel has some necessary tools that are used to load model families or to create 
the model of a window in a drawing. The other panels, apart from those discussed above, 
contain the tools that are contextual and are used to edit elements when placed in a drawing 
or selected from a drawing for modification.

Application Frame
The application frame helps you manage projects in Autodesk Revit MEP. It consists of  
Application button, Application Menu, Quick Access Toolbar, InfoCenter, and Status Bar. 
These are discussed next.

Application Button
The Application button is displayed at the top-left corner of the Autodesk Revit MEP 2014 
interface. This button is used to display as well as close the Application Menu. 

Application Menu 
The Application Menu contains the tools that provide access to tools such as Open, Close, and 
Save. Click on the down arrow on the Application button to display the Application Menu, as 
shown in Figure 1-11. Alternatively, press ALT+F to display tools in the Application Menu.

Quick Access Toolbar
The Quick Access Toolbar, shown in Figure 1-12, contains the options to undo and redo 
changes, open and save a file, create a new file, and so on. 

By default, the Quick Access Toolbar contains the options such as Open, Save, Redo, Undo, 
and so on. You can customize the display of the Quick Access Toolbar by adding more tools 
and removing the unwanted tools. To add a tool or a button from the panel of the ribbon to 
the Quick Access Toolbar, place the cursor over the button; the button will be highlighted. 
Next, right-click; a flyout will be displayed. Choose Add Quick Access Toolbar from the 
flyout displayed; the highlighted button will be added to the Quick Access Toolbar. The 
Quick Access Toolbar can be customized to reorder the tools displayed in it. To do so, choose 
the down arrow next to the Switch Windows drop-down, refer to Figure 1-12; a flyout will 
be displayed. Choose the Customize Quick Access Toolbar option located at the bottom of 
the flyout; the Customize Quick Access Toolbar dialog box will be displayed. Use various 
options in this dialog box to customize the display of toolbar and choose the OK button; the 
Customize Quick Access Toolbar dialog box will close and the tools in the Quick Access 
Toolbar will be reordered.  



1-16 				                                       	    Exploring Autodesk Revit MEP

Figure 1-11  The Application Menu

Figure 1-12  The Quick Access Toolbar 

InfoCenter
You can use InfoCenter to search for information related to Revit MEP (Help), to display the 
Subscription Center panel for subscription services and product updates, and to display the 
Favorites panel to access saved topics. Figure 1-13 displays various tools in InfoCenter.
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Figure 1-13  The InfoCenter

Status Bar
The Status Bar is located at the bottom of the interface screen. When the cursor is placed 
over an element or a component, the Status Bar displays the name of the family and the type 
of the corresponding element or components. It also displays prompts and messages to help 
you use the selected tools.

View Control Bar
The View Control Bar is located at the lower left corner of the drawing window, as shown 
in Figure 1-14. It can be used to access various view-related tools. The Scale button shows 
the scale of the current view. When you can choose this button, a flyout containing standard 
drawing scales is displayed. From this flyout, you can then select the scale for the current view. 
The Detail Level button is used to set the detail level of a view. You can select the required 
detail level as Coarse, Medium, and Fine. Similarly, the Visual Style button enables you to 
set the display style. The options for setting the display style are: Wireframe, Hidden Line, 
Shaded, Consistent Colors, Shaded, and Raytrace.

Figure 1-14  The View Control Bar

Options Bar
The Options Bar provides information about the common parameters of a component type. 
It also displays options for creating or editing them. The options displayed in the Options Bar 
change according to the type of component being created and selected for editing. Figure 1-15 
displays the options in the Options Bar to create a structural column.

Figure 1-15  The Options Bar with different options to create a structural column
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Type Selector
The Type Selector drop-down list is located in the Properties Palette for the currently invoked 
tool. On invoking the Duct tool, the properties of the duct will be displayed in the Properties 
Palette. In this Palette, you can use the Type Selector drop-down list to select the required type 
of the beam. The options in the Type Selector drop-down list keep changing, depending upon 
the current function of the tool or the elements selected. The Type Selector drop-down list 
can also be used to specify the type of an element or component while placing that element 
or the component in a drawing by using the Place a Component tool. You can also use this 
drop-down list to change the type of a selected element.

Drawing Area
The Drawing Area is the actual modeling area where you can create and view the building 
model. It covers the major portion of the interface screen. You can draw building components in 
this area. The position of the pointing device is represented by the cursor. The Drawing Area 
also has the standard Microsoft Windows functions and buttons such as close, minimize, 
maximize, scroll bar, and so on. These buttons have the same function as that of the other 
Microsoft Windows-based programs.

Project Browser
The Project Browser is located below the ribbon. It displays 

Figure 1-16  The Project Browser

project views, schedules, sheets, families, and groups in a 
logical, tree-like structure, as shown in Figure 1-16 and helps you 
to open and manage them. To open a view, double-click on 
the name of the view, or drag and drop the view in the 
Drawing Area. You can close the Project Browser or dock it 
anywhere in the Drawing Area. 

Note
If the Project Browser is not displayed on the screen, 
choose the View tab from the ribbon and then select the 
Project Browser check box from View > Windows > 
User Interface drop-down.

The Project Browser can be organized to group the views 
and sheets based on the project requirement. For example, 
while working on a large project with a number of sheets, 
you can organize the Project Browser to view and access 
specific sheets. 

Note
In the Project Browser, you can expand or contract the view listing by selecting the ‘+’ or ‘-’ 
sign, respectively. The current view in the drawing window is highlighted in bold letters. The 
default project file has a set of preloaded views.
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Keyboard Accelerators
In Autodesk Revit MEP, accelerator keys have been assigned to some of the frequently used tools. 
These keys are shortcuts that you can type through the keyboard to invoke the corresponding 
tool. The accelerator key corresponding to a tool appears as a tooltip when you move the 
cursor over the tool.

Properties Palette
The Properties palette, as shown in Figure 1-17, is a modeless interface, which displays the 
type and element properties of various elements and views in a drawing. The Properties 
palette is dockable and resizable, and it supports multiple monitor configurations. The 
Properties Palette is displayed in the Revit interface by default and it shows the instance 
properties of the active view. When you select an element from a drawing, the Properties 
Palette displays its instance properties. You can also access the type properties of the selected 
element from the Properties Palette. To do so, choose the Edit Type button from the Palette; 
the Type Properties dialog box will be displayed. In this dialog box, you can change the type 
Properties of the selected element.

Figure 1-17  The Properties Palette
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In the Properties palette, you can assign a type to the selected element in a drawing using the 
options from the Type Selector drop-down list. In Revit MEP, you can toggle the display of 
the Properties palette in its interface. Choose the Properties button in the Properties panel 
of the Modify tab to hide it. Similarly, you can choose the Properties button to display the 
palette if it is not visible in the interface.   

Tip: As you become accustomed to use Autodesk Revit MEP, you will find these Keyboard 
Accelerators quite useful because they save the effort of browsing through the menus.

Dialog Boxes
Some Autodesk Revit MEP tools, when invoked, display a dialog box. A dialog box is an interface 
for accessing, specifying, and modifying the parameters related to that tool. For example, 
when you choose Save As > Project from the Application Menu, the Save As dialog box is 
displayed, as shown in Figure 1-18. A dialog box consists of various parts such as dialog label, 
radio buttons, text or edit boxes, check boxes, slider bars, image box, buttons, and tools, which 
are similar to other windows-based programs. Some dialog boxes contain the Browse button, 
which displays another related dialog box. There are certain buttons such as OK, Cancel, 
and Help, which appear at the bottom of most of the dialog boxes. The names of the buttons 
imply their respective functions. The button with a dark border is the default chosen.

Figure 1-18  The Save As dialog box

Multiple document Environment
The multiple document environment feature allows you to open more than one project at a 
time in a single Autodesk Revit MEP session. This is very useful when you want to work on 
different projects simultaneously and make changes with reference to each other. 
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Sometimes, you may need to incorporate certain features from one project into the other. With 
the help of multiple document environment feature, you can open multiple projects and then 
use the Cut, Copy, and Paste tools from the Clipboard panel of the Modify (type of element) 
tab to transfer the required components from one project to another. These editing tools can 
also be invoked by using the CTRL+C and CTRL+V keyboard shortcuts.

To access the opened projects, click

Figure 1-19  Selecting an option from the Switch Windows 
drop-down

 
on the Switch Windows drop-down 
in the Windows panel of the View tab; 
the options for the names of different 
opened project files will be displayed, 
as shown in Figure 1-19. Like other 
Microsoft Windows-based programs, 
you can select and view the opened 
projects using the Cascade and Tile 
tools from the Windows panel of the 
View tab. The cascaded view of 
projects is shown in Figure 1-20.
 

Figure 1-20  The cascaded view of projects

Interoperability of Autodesk Revit MEP
The models or geometries created in Autodesk Revit MEP can be easily exported to 
AutoCAD and AutoCAD Architecture in the DWG file format. This enables structural engineers 
to collaborate with Architects.

One of the important aspects of the job of a structural engineer is to collaborate and share 
information with the rest of the design team including the architect. To facilitate this 
requirement, Revit MEP 2014 follows a wide range of industry standards and supports various 
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CAD file formats such as DWF, DGN, DWG, DGN, IFC, SKP, and SAT. For image files, it 
supports JPG, TIFF, BMP, PNG, AVI, PAN, IVR, and TGA file formats. Besides these, the 
formats that are supported by Revit MEP include ODBC, HTML, TXT, XML, XLS, and MDB. 
Autodesk Revit MEP is compatible with any CAD system that supports the DWG, DXF, or DGN 
file format. Revit MEP can import the models and geometries as ACIS solids. This enables 
engineers to import models from AutoCAD Architecture and AutoCAD MEP (Mechanical, 
Electrical, and Plumbing) software and to link the 3D information to Revit MEP. This feature 
makes Autodesk Revit MEP 2014 an efficient, user-friendly, and compatible software. 

Building Information Modeling and Autodesk 
Revit MEP 2014
Building Information Modeling (BIM) is defined as a design technology that involves the 
creation and use of coordinated, internally consistent, and computable information about a 
building project in design and construction.

Using BIM, you can demonstrate the entire life cycle of a building project starting from 
the process of construction, facility operation, and information about quantities and shared 
properties of elements. BIM enables the circulation of virtual information model from the 
design team to contractors and then to the owner, thereby updating them about the changes 
made in the model at each stage. The ability to keep information up-to-date and make it 
available in an integrated digital environment enables the architects, owners, builders, and 
engineers to have a clear vision of the project before the commencement of actual construction. 
It also enables them to make better and faster decisions to improve the quality and profitability 
of projects. Autodesk Revit MEP 2014 is a specially designed platform based on BIM. 

In Revit MEP, the analytical and physical representations of an MEP model are created 
simultaneously. These representations are different views of a computable building model that 
contains necessary information for a third-party analysis application which is done with the 
help of a common modeling interface. You can use Revit API to move data directly from the 
Revit MEP building information model to the analysis software. Further you can bring back 
the analysis reports while keeping the analysis, design, and documentation synchronized.

Revit MEP’s parametric model represents a building as an integrated database of coordinated 
information. In Revit, a change anywhere is a change everywhere. A change made in your 
project at any stage is reflected in the entire project, and also, due to the parametric behavior 
of elements, the project is updated automatically. Also, the integration of Revit MEP with the 
available in-built commercial tools such as solar studies, material takeoffs, and so on greatly 
simplifies the project design and reduces the time consumed for analysis, thereby enabling 
faster decision making.

worksharing using Revit Server 
Worksharing is a method of distributing work among people involved in a project, to 
accompnish it within the stipulated period of time. In worksharing, each person involved 
in the project is assigned a task that has to be accomplished through proper planning and 
coordination with the other members of the team.
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In a large scale building project, worksharing helps in finishing a project in time and 
meeting the quality requirements that are set during the process. Generally, in a large scale 
building project, the professionals such as structural engineers, architects, interior architects, 
and MEP engineers are involved in their respective fields to accomplish the project. So, the 
distribution of work at the primary stage is made on the basis of the area of specialization. 
Each professional has his own set of work to perform for the accomplishment of the project. 
Therefore, worksharing is an important process that is required to be implemented efficiently 
to complete the project in time.
  
In Autodesk Revit MEP, you can apply server-based worksharing with the help of Revit Server, 
which is a server application. Revit Server uses a central server and multiple local servers for 
collaborating across a Wide Area Network (WAN). The central server hosts the central model 
of a workshared project and remains accessible to all team members over the Wide Area 
Network. Similarly, the local server is  accessible to all team members in a Local Area Network 
(LAN). The local server hosts a local updated copy of the central model. In the Worksharing 
environment, the team members are not aware of the local server, as it is transparent in their 
daily operations. Refer to Figure 1-21 for the network model of Revit Server.

Figure 1-21  The Network Model of Revit Server

In Worksharing environment, a team member starts working on the local model of the central 
model. The local model will be saved in the computer of the team member. As the team 
member works, the local server requests updated information from the central model on 
the central server, using available network capacity to transfer the data over the WAN. The 
updated version of the model is stored on the local server, so the updates are readily available 
when a team member requests for them.
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Autodesk Revit MEP Help
Autodesk Revit MEP 2014 helps you to easily understand the tools and methods used in a 
project. In Autodesk Revit MEP 2014, you can access online help documentation (Autodesk 
WikiHelp) as well as local (offline) help documentation.

To access the help feature, click on the Help down arrow on the right of the InfoCenter; a 
flyout with various help options will be displayed. The options to access the help are discussed 
next. 

Using the Local Revit MEP 2014 Help			           
To access the local Revit MEP 2014 help, choose the Help tool from InfoCenter; the Revit 
Help page will be displayed, as shown in Figure 1-22. You can also display the Revit Help 
page by pressing the F1 key. You can use this page to get information on various tools and 
enhancements introduced in Autodesk Revit 2014. There are four tabs provided in this page. 
The options in these tabs will help you speed up the search process. These tabs are discussed 
next.

Figure 1-22  The partial view of the local Revit Help page

Contents Tab
This tab is chosen by default. There are following links displayed in the left pane of the Contents tab: 
Revit Users, BIM Managers, and Installation.
 
If you click on the Revit Users link, the user’s guide and information to various help topics 
in Revit software (MEP, Architecture, and Structure) are displayed in the right pane. You can 
click on the required link to view the desired topic.

In the Contents tab, click on the BIM Managers link; the links related to the topics that Revit 
administrators and CAD/BIM managers may need to manage Revit for a large organization 
are displayed. 
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You can click on the Installation link to display the information related to the installation 
of Revit software. You can also use this information to learn the glossary of the terms used 
for installation and installation troubleshooting. 
 
Index Tab
The Index tab displays the complete index of tools and options of Revit software in an 
alphabetical order. To search for information regarding a tool or an option, type the name of 
the tool or its related word in the Search for the keyword text box and press ENTER. If Revit 
finds any reference to the word entered, it will automatically be highlighted in the list area. 
You can choose the desired topic from the list area to view the information related to  it. 

Search Tab
In Revit, you can access help files related to certain keywords. To do so, choose the Search 
tab in the displayed page. Various options related to the Search tab will be displayed in the 
left pane. Type any keyword in the Search help for edit box and choose the Search button; 
various topics related to the search will be displayed in a list box below the edit box. You can 
click on the link of the topics required; the information related to it will be displayed in the 
right pane.

Favorites Tab
In the Revit Help page, you can add any of the searched topics to favorites by choosing the 
Add to Favorites button displayed in the top right corner of the Revit Help page. To view 
the topics you have added as favorites, choose the Favorites tab in this page.

The New in Revit 2014 area of the offline help page gives information about enhancements 
in Autodesk Revit and other softwares related to the same platform.

The Platform Enhancements node contains information about enhancements in Revit 
softwares namely Revit MEP, Revit Architecture, and Revit Structure.

The MEP Enhancements node contains information about enhancements in Revit MEP. In 
Autodesk Revit MEP 2014, the enhancements in Plumbing template, calculation method for 
duct and pipe for straight segment and fittings, procedure of adding air terminals to ducts 
and more have been introduced.

The Structural Enhancements node in this page contains information about the enhanced 
features in Autodesk Revit MEP 2014. In Revit MEP 2014, the enhancements in reinforcement, 
positioning for structural framing, structural analysis, and multi-rebar annotations are 
introduced.

The Architectural Enhancements node contains enhancements information exclusively for 
Revit Architecture application.

Using the Autodesk WikiHelp					   
In Autodesk Revit MEP 2014, Autodesk WikiHelp has been introduced to access various help 
topics online. You can access Autodesk WikiHelp for Revit MEP by choosing the Help tool 
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from the InfoCenter. On doing so, the Autodesk WikiHelp page will be displayed, as shown 
in Figure 1-23. On this page, different areas such as Browse Help, Add Knowledge, Most 
Popular, Recent Updates, and Newest Videos are displayed. You can click on the required 
link from these areas to get the related information.

Figure 1-23  The Autodesk WikiHelp page

In the Browse help area, various help options related to Autodesk Revit are available. You can 
click on the required option to display the help page corresponding to the option. The Add 
Knowledge area contains various learning resources. You can click on the desired option in 
this area to get the information related to it. The Recent Updates area displays latest updates 
made in Revit 2014.

Using the Context Sensitive Help
If you need help related to a selected tool or a dialog box, Autodesk Revit MEP provides several 
options to access the relevant information. Many dialog boxes contain the Help tool which 
can be used to view help for the options of that dialog box or other related topics. If the Help 
button is not available, you can press the F1 key, while the dialog box is open, to access the 
related information. To enquire about a tool, place the cursor over it; the Help message box 
will be displayed. Now, you can press the F1 key to view more help contents pertaining to the 
button, in a separate window. To turn off the Help tooltips for buttons, choose the Options 
button from the Application Menu; the Options dialog box will be displayed. In the User 
Interface tab of this dialog box, select the None option from the Tooltip assistance drop-down 
list in the Tooltips area. Now, choose OK to close the Options dialog box. 	   


